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chapter l3 
 
 

 
FILL-IN-THE-BLANK COMPUTING 

 The Basics of Spreadsheets 
 
Learning objectives 
 
  

 Explain how data is organized in spreadsheet software  
 Describe how to refer to spreadsheet rows, columns, and cell ranges 
 Explain relative and absolute references  
 Apply concepts of relative and absolute references when filling a formula  
 Explain the concept of tab-delimited input and output 
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FILL-IN-THE-BLANK COMPUTING 
 The Basics of Spreadsheets 

 
There are 10 kinds of people in the world: Those who know binary and those who don't. 

 
-ANONYMOUS 

 
  
FR0M THE VERY BEGINNING of mankind's use of symbols and writing, we have arranged information to 

make it more useful. Organized information is easier to understand, easier to remember, and easier to navigate. 

With the invention of information technology, there is a further reason to organize information: Computers can 

process it for us. This is a bonus we gain for very little effort, especially when we use spreadsheets. 

 In this chapter we introduce the basic ideas of spreadsheets. Because they make computer users so 

effective, especially in business, spreadsheets have become very sophisticated. This chapter introduces you to 

the basic ideas, making them personally useful. If you need more power, you'll have a great foundation for 

learning more; if not, you'll be acquainted with a very versatile tool. 

 We begin by introducing the basics of spreadsheet use, including constructing lists, sorting them, 

naming cells, and controlling the format of the entries. Next we add numeric information to the spreadsheet 

and learn how to manipulate it, which teaches us about formulas, relative and absolute references, and 

functions. Computing new numbers from numbers already in the table is what spreadsheets do best, and 

happily, it is extremely easy to learn and use. After learning these basic concepts, we practice them on 

"everyday" problems; that is, tasks of personal interest: We build a 1-minute calendar for our weekly schedule, 

set up a transportation schedule so we don't miss the bus so often, make a "cheat sheet" for computing 

discounts at the music store, and develop data for helping decide how much to borrow for a "big ticket" 

purchase like a car or stereo. None of these tasks is so difficult as to require a computer, but since we're using a 

computer anyway, we can solve them quickly to our personal satisfaction. Finally, we use the Best Movie list 

to practice manipulating data in a spreadsheet. 
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Commonly, textual information is organized into lists, as we know from making shopping lists, invitation lists, 

"to do" lists, class lists, and many others. As a running example, we'll use a list of migratory birds: 

 

Short-tailed shearwater  
Swainson's hawk  
Wheatear  
Arctic tern  
Willow warbler  
Long-tailed skua 

 

Looking at the list, you see that it contains six bird names even though you may not be too familiar with birds. 

You probably figured it out because you know that hawks and warblers are birds and the items appear on 

separate lines. The names themselves are quite diverse as text: single word names, double word names, 

hyphenated names, and even a possessive. Since the computer doesn't have your knowledge, it needs to be told 

the extent of each entry, that is, how much text there is in each entry The separate line cue helps, but if the 

entries were very long, they would spill to another line, and that cue wouldn't work. 

 
Kinda the Same. Spreadsheet software is available from many sources. The content of this 
chapter applies generally to Microsoft Excel, OpenOffice, AppleWorks, Lotus 123, etc. Every 
system is different, however, because menus and defaults are particular to each system. With a 
moment's exploration you should be able to perform the operation on your system. 

 
 
 An Array of Cells 
 
 To help us create a list, spreadsheets give us an array of cells that we fill in to set up our list. 
  

    
 
The lines are pan of the graphic user interface; they help us and the computer agree on what an item is and how 
the positions of items are related to each other. 
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Notice that four of the six items in the list do not fit within the lines provided. Even though it takes more space 

to display the entry than the Computer provides entries do not straddle cells. Each occupies only the cell into 

which it is typed, as is shown when we enter test data in the cells to their right. 

   
 

The test data, which blocks the long entries from spilling to the empty cells on the right, indicates that entries 

that are too long are clipped. (items only spill when the cells to their right are unused.) We can either let the 

entries be clipped, or make the cells wider, as explained in Table 13.1 on page 372. We choose the latter. 

 
Sorting the Data 
 
A common operation on any list, especially when it gets long, is to alphabetize or sort it. Spreadsheet software 

makes sorting easy We must say what items to sort, so naturally, we must select the list. We select the list by 

dragging the cursor across the cells- the resulting selection is indicated with highlighting. 

   
All of the items inside the blue box are selected, including the white item, which is a different color only 

because it was the first cell selected, that is, it's the place where the dragging began. The Sort ... operation is 

found among the menu items. It allows us to choose ascending or descending order. The software uses an 

algorithm like the one we discussed in Chapter 10 to sort the items. Sorting our list of birds in ascending order 

produces the following result. 
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Notice that the sorting software orders the list alphabetically on the first letter of the entry, not on the type of 

bird, for example, "hawk." This is consistent with the spreadsheet view that the cell entries are "atomic" or 

"monolithic" from the computer's point of view, meaning that the computer does not consider any of their 

constituent parts. If the list contained both Swainson's hawk and Swainson's warbler, they would appear 

together in sorted order. But if we wanted those birds to be grouped with the hawks and the warblers 

respectively, then it would be necessary to sort on the second part of the name. That would require the type of 

the bird (e.g., "hawk" or "warbler") to be in a separate cell-in its own column. 

 
 
Adding More Data to the List 
 
Our list is not so complete. We will leave the common names in a single column, but we'll add the scientific 

names using two columns, one for genus and one for  species. 

 

   
 
 
As we know, scientific names are usually written in italics. Spreadsheets give us the ability to format cell 

entries with the kinds of formatting facilities found in word processors, such as italics, bold, font styles, font 

sizes, justification, colored text and backgrounds, etc. Naturally, the formatting facilities are found under the 

Format menu. We italicize the scientific names and right justify the genus name so it looks like it is paired 

with the species name. 
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Naming rows and Columns. Now suppose we want to alphabetize on the second column, the genus. We begin 

by selecting the whole list because that is the information we want to reorder. With three columns selected, how 

do we specify that the second column is the one to sort on rather than the first column? 

   

   
Spreadsheet programs automatically provide a naming scheme for referring to specific cells. The columns are 

labeled with letters and the rows are labeled with numbers. This allows us to refer to a whole column, as in 

column cm or to a whole row, and in row 4. or to a dingle cell by specifying both the column letter and the row 

number, as in B2. Thus, when we request to sort the entries, the sorting software displays the Sort GUI 
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We choose to sort the selected rows based on entries in column a (which contains our genus entries) by 

clicking on the directional arrows. This produces the following result. 

   
Notice that the naming scheme allows us to refer to a group of cells, by naming the first cell and the last cell 

and placing a colon (:) in between, as in "the cells B2: D7 are highlighted in the figure." This kind of reference 

is called a cell range.  

 

TRY IT 

Q: What is the cell range for the scientific names of the birds whose common name ends with "-tailed"? 

A: C5 : D6 because the two birds with "-tailed" in their names are in rows 5 and 6, and the scientific names 

span Columns C and D. 

 

Headings. Though the software provides names for referring to cells, it is convenient for us to name the rows 

and columns with more meaningful names. For example, we can label the columns with the type of 

information entered. 

   
 

Summarizing, spreadsheets are made up of cells that are displayed to the user as rectangles in a grid. 

Information is entered in a cell and treated as an elemental piece of data no matter how long it is or if it 

contains spaces or other punctuation symbols. Generally, we build a list of items that can be sorted simply by 

selecting them, and requesting the sorting operation. If multiple columns must be sorted, we select all of the 

information to be reordered, request Sort, and specify the column to sort on when the GUI asks for it.  
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Spreadsheets automatically provide a labeling for specifying the column/row position of any element in the 

grid, but it is also convenient to add our own, more significant names. Table 13.1 gives othe common 

operations useful for lists. 

 
 

  
 
COMPUTING WITH SPREADSHEETS 
 
Though spreadsheets don't have to contain a single number to be useful, their most common application is to 

process numerical data. Numerical data is usually associated with textual information, too, so most 

spreadsheets have both. For example, suppose our migratory bird spreadsheet has been further filled out, as 

shown in Figure 13.1. 

 

 
The migration column gives the end points of the bird's semiannual migration route, the Distance column gives 

the approximate length of that flight in kilometers, and Body Len gives the size of the bird (length) in meters. In 

the following discussion the Genus, Species, and migration columns will be hidden. 
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Writing a Formula  
 
Suppose we wand to find out how far Swainson’s Hawk flies in miles rather than kilometers. Because one 

kilometer is 0.621 miles, we must multiply the value in cell F2 by 0.621 to find out. We can perform this 

specific computation with a calculator, but we will probably want to know the distances in miles for all of the 

migration flights. So, we decide to create a new column for the distance in miles, and instruct the spreadsheet 

how to compute it. 

 

  
 
What entry so we want in position H2? We’d like it to be equal to F2X0.621, so we type 
 
=F2*0.621 
 
Which appears in the H2 window and the Edit Formula window on the edit bar above. 
 

   
 
 
Notice that we use an asterisk (*) for the multiplication symbol rather than a cross or dot. When we type return, 

the value in H2 is the result of the computation, that is, 8383.5 miles. 
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We have just instructed the spreadsheet software to compute the value in cell H2 by telling it what the cell 
should equal. We did this by typing a formula into the cell. Formulas, which begin with an equal sign (_), 
define the value for the entry based on the values of other entries. We used numbers (0.621), cell references 
(F2), and standard arithmetic operations (*) as found on a calculator. If we ever  change our estimate of the 
distance Swainson's Hawk migrates, that is, change the value in F2, then the spreadsheet software will 
automatically change the value in H2 to reflect the revision. 
 

Equal Opportunity. When we type characters into a cell, the spreadsheet software needs to 
know if we are giving it data that should be stored, or if we are giving it a formula saying how to 
compute information for that cell. The equal sign (=) is the indicator: It's a formula if it starts 
with =; otherwise it's data. 

 

Consider the formula a bit more. We entered the formula =F2*0.621 into cell H2. The cell contains this 
formula, not 8383.5. We can prove this by temporarily changing the value in F2 from 13,500 to, say, 14,000, 
and noting that H2 automatically increases to 8694. 
 
By specifying this formula, we have defined an equation 
 
H2 = F2 X 0.621 
 
just as we would in algebra. Recall that such an equation means that both sides of the equal sign refer to the 
same value. So, entering the formula into H2 means that we want the cell to have the value of F2 * 0. 621 now 
and forever. Because F2 presently contains the data 13,500, cell H2 displays as 8383.5. When we change the 
value of F2, the value of H2 must change, because the equality must be pre served. Thus, when we put a 
formula into a cell (the right side of the equation), the computer does the math and displays its value (the left 
side of the equation).  
 
Repeating a Formula 
 
We can specify a similar computation for cell H3 and the other cells in that column by entering them in the 
same way. 
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Copy/Paste. Thinking about it, however, we might guess that Copy/Paste will work to replicate the equation to 
other cells. So, we select cell H2, which, in Excel, is indicated by an animated highlight (the dashes revolve 
around the box). Other spreadsheet software simply shows a solid box around the item. 
 

  
 
The cell's contents are shown in the Edit Formula window. We Copy this cell (^c), select the remaining cells 
in the column by dragging the mouse across them, and Paste (^v). The result shows all of the distance values 
computed. This is quite a bit of computation for very little effort on our part. 
 

  
 
Notice that in the Edit Formula window the equation shows as F3*o.621. This corresponds to the computation 
for the cell H3, the first of the highlighted cells (white) into which we pasted the formula. And we notice a 
curious thing: Whereas the formula we pasted was F2*o.621, the formula was transformed into F3*0.621 when 
it was pasted into H3; it was transformed into F4*0.621 for H4, etc. This is exactly what we want for this 
column, namely that the value in column H is based on the corresponding values in column F. The software 
makes this transformation for us automatically. (This is explained in Transforming Formulas.) 
 
Fi11ing. It's possible for these computations to be performed even more easily! Let's go back and redo them 
from the point where we had just entered the formula for the Swainson's Hawk, 
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Notice in the image that the highlighted cell H2 is outlined in color, but there is also a small box or tab beyond 
the cell’s lower right corner (near the cursor). This is called its fill handle. We can grab this handle with the 
cursor and “pull” it down the column, applying the operation we just performed on H2 to those cells. 
 
 

 
 
 
This process is known as filling. It’s automated copying and pasting! Filling is a shortcut that allows us to 
replicate, that is copy/paste, the contents of the cell with the fill handle, saving us from explicitly setting each 
cell in the column or manually using the copy/paste operations. Whenever the fill handle is visible on a 
highlighted cell, the contents can be replicated by filling.  
 
TRY IT 
 
 
Q: Suppose we would also like to see the birds’ body lengths measured in inches. Using the fact that a meter is 

39 inches, what steps do we perform to add this information to the spreadsheet? 

 

A: Step 1. The recommended first step is to laved the next column, I, with an appropriate heading, though it is 

not actually required. 

Step 2. Enter the formula =G2*39 in cell I2, which computes the length of Swainson’s Hawk in inches. 

Step 3 Click once in cell I2 to select it, and drag the fill handle down the column to fill in the lengths of the 

other birds. 

 



 377

 
 
 

  
 
 
 
Transforming Formulas: 
Relative versus Absolute 
 
 
The software automatically transforms the formulas as it pastes them or fills them into a cell because we used a 
relative cell reference when we wrote F2 and c2. Spreadsheets allow two kinds of cell references-relative and 
absolute-and we must be careful which we use. The absolute forms for these cells are $F$2 and $C$2; they tell 
the software never to change the reference when filling or pasting. Here's what's happening. 
 
Relative means "relative position from a cell." When we pasted the formula =F2*0.621 into H2, the software 
noticed that cell F2 is two cells to the left of H2. That is, the formula refers to a cell in the same row, but two 
cells to the left. 
 
 

  
 
Since this is a relative reference, the software preserves the relationship of "two cells to the left in the same 
row" between the position of the referenced cell and the cell where the formula is pasted. So, when we Paste 
or fill this same formula into a3, the software transforms the formula so it still refers to the cell two cells to the 
left in the same row; that is, the formula is changed to =F3*o.621. And similarly whenever a relative formula is 
pasted or filled. 
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An absolute reference always refers to the fixed position-the software never adjusts it. 
 
Because there are two dimensions in spreadsheets-columns and rows-there are actually two ways a formula can 
be relative. This makes four cases: 
 
  F2--column and row are both relative 
  $F2-absolute column, but relative row 
  F$2-relative column, but absolute row 
  $F$2-column and row are both absolute 
 
For example, assume cell A1 contains 1. When the formula =A$1+1 is filled from A2 down column A into 
new rows, the formula is untransformed and 2's are computed, because the cell's row reference ($1) is absolute 
and the column reference, though relative, didn't change as we filled down the column into new rows. All  
cells refer to the same cell, A1. But when that formula is filled from B1 across row 1 into new columns, the 
relative column reference (A) is transformed, =B$1+1, =C$1+1,  =D$1+1, etc., and the numbers 2, 3, 4, . . . are 
computed. 
 
 

   
 
The spreadsheet software preserves the relative position in whichever dimension(s) you specify, and leaves 
absolute references unchanged. 
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Cell Formats 
 
 
Although it is amazing that the migratory birds fly so far twice a year, it is perhaps even more impressive that 
the smaller birds do it. One analysis that a biologist might make to take both distance and size into 
consideration is to divide the bird's size into the distance flown. This flying score measures each bird in a way 
that allows a more equal comparison. 
 
We will use the distance in kilometers (column F) and length in meters (column G) so that the "meters" cancel 
out giving a "unitless" score. As before, we define a new column, and enter the equation into the first cell. 
After finding the hawk's score, we fill the column with the formula and compute the results. 
 

   
The scores are somewhat difficult to read because they have too many digits, or as a mathematician might say, 
more digits than are significant. For the numbers to be useful, we need to format them, say, by making them 
whole numbers. 
 
All spreadsheet software provides control over the format of the information displayed. For example, Excel 
displays this GUI for formatting cells. 
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This GUI gives us control over the types of information in the fields (Category); control over the number of 
decimal digits for the Number category chosen; control over setting the "1000x" separators (commas for North 
America); and control over the display of negative numbers. 
 
When we reduce the number of decimal digits to 0, that is, specify whole numbers only, we get this result. 
 
 

  
 
This confirms our intuition that smaller birds score higher even if their distances flown are not the largest. 
 
FUNCTIONS: 
 
Picking the Willow warbler as the most amazing flier is based on its being the maximum value in the Flying 
score column. Visually finding the maximum for this column is easy to do, but it's somewhat harder to do for 
the other columns because the entries have the same number of digits; also the list can be much longer. So we 
set up the spreadsheet to compute the maximum. 
 
Finding the Maximum 
 
 
Spreadsheet software provides functions for computing common summary operations such as totals (sum), 
averages, maximums (max), and many others. To use these functions, we give the function name and specify 
the cell range to be summarized in parentheses after it. So, for example, we write 
 
=max(J2:J7) 
 
in a cell at the bottom of column J, and label that row with the "maximum:" caption. 
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The formula directs the software to find the largest value in the cell range J2: J7, that is, the Flying score 
column. Notice that there is a triangle pointer by the function MAX in the upper left corner of the image. We'll 
find a list of the available functions here. When we don't remember the function names, we can check this list; 
or check the list under Edit > Insert Function . . . . 
 

The Easy Case. Functions and column letters are not case sensitive in spreadsheets, so we 
can type them however we wish. The software stores the result as uppercase, which is how 
it's displayed after its initial entry.  

 
  
Having computed the maximum for Flying score, we can figure the maximum of the other columns as before, 
by filling. That is, we grab the s9 cell by its fill handle and pull it left to column F. The result is curious. 
 
 

  
 
The "1" in the Body Len column is a whole number rather than 0.52, the largest of the two-decimal-digit 
fractions in column G. Why? Because the maximum value. computation in the Flying score column inherits the 
whole number setting from before. When we drag it across to the other columns, it brings its formatting 
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Figure 13.2. Final spreadsheet for the migratory birds. 
 
DAILY SPREADSHEETS 
 
Some people use computers all day and never use a spreadsheet; others use spreadsheets constantly. The rest of 
us are somewhere in between: Spreadsheets are convenient and versatile tools that simplify computing. In this 
section we look at a few personal applications as a way to gain a bit more experience with using spreadsheets.  
 
Many opportunities exist to use spreadsheets to organize one's personal information. We can 
 

 track our performance m our personal exercise program-distances, time, reps 

 set up an expense budget for the next term 

 keep a list of the books and CDs we've lent to others 

 follow our favorite team's successes by importing the season schedule and annotating it with wins and 

losses and our own comments about the games 

 record flight hours or dives after each flying or scuba lesson 

 document expenses such as travel, or income such as tips for income tax purposes 

 save records generated while online banking 

 

Spreadsheets can even serve as an address book or recipe file. 
 
Here are more ways to apply spreadsheets in personally relevant ways. 
 
CALENDAR 
 
Calendars are everywhere, and computers come with calendar software, so making a calendar with a 
spreadsheet hardly seems like an important application. But you would be surprised. Some people find 
calendar software clumsy, some peoplewant to restructure their week, beginning, say on Wednesday, some 
people want a 
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mix of larger/smaller appointment timeslots, workers with "2-on-l-off' jobs want double week calendars, etc. 
At a meeting, one might set up a schedule for room or equipment usage or for a team's practices; it's often 
convenient to present information as a calendar, say espresso sales by hour and day. Making a custom calendar 
solves these problems, and it only takes a minute. Really! 
 
To begin we enter a day of the week into a cell in the spreadsheet, say Sunday, and format it as we like it, 
perhaps with bold letters and a background color. Depending on which software we are using, we either drag 
the fill handle across the next six columns to fill in the successive days of the week, or we request such a fill 
operation using the menus. 
 

   
 
The result should be enhanced by the day of the month. So, we enter a date, say January 2, in the row below, 
format it, and fill it across. 
 
 

    
 
That result is ready for the times of day. We enter 8 : 00 Am into cell A5, format it to taste, including bold and 
color . We want half hour appointment slots, but normally the time fill increments by hours rather than half 
hours. We could figure out how to change the increment, but instead we enter s : 30 Am in cell A6. 
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Using this pair of cells we fill down the column to 8: 00 PM. This achieves the desired half hour appointment 
times. 
 

   
 
This double-cell fill is an easy way to cause the spreadsheet software to count by a specific amount. Note that 
entering 8 :00 without the "Am" results in an international or military time fill. 
 
The result is shown in Figure 13.3 with example contents. 
 
 
 

   
Figure 13.3. Calendar spreadsheet with envies added. 
 
 



 386

Chapter 13 Fill-in-the-Blank Computing-The Basics of Spreadsheets 
 
The point is not that we've created a spectacular appointment calendar, but that the spreadsheet software makes 
it easy to create one. We did almost no typing: We entered Sunday and filled; we entered January 2 and 
filled; we entered 8 : 00 Am and 8: 30 Am and filled the pair. We were done! It's possible to do this in under a 
minute. We have a custom calendar exactly matching our needs. 
 
The calendar was so easy because spreadsheet software, when it fills certain types of data such as days, dates, 
times, etc., automatically increments, that is, automatically adds 1 as it fills each cell forming a series. The 
software knows that "adding 1" to Sunday results in Monday, and "adding 1" to January 31 results in February 
1. It assumes, when it sees values like Sunday, that it's not ASCII data, but rather one of these special data 
types. If you type in Sunday and you want to copy the word Sunday, that is, you don't want to treat it as a 
special type of data, then don't use series fill. Simply Copy/Paste. Finally, double-cell fill also indicates a 
series, where the amount of increment between successive items is the difference between the pair. 
 
Discount Table 
 
Because downloading music for MP3 players is so popular, music stores that sell CDs try to compete by 
offering "store credit" discounts, that is, discounts on future purchases at the store. One store offers 
 
$1.00 store credit for each $10.00 spent plus 
$3.00 store credit for every two CDs purchased. (One CD earns only $1.00 credit.) 
 
To help you to figure your credits, you can construct a table, which you can print out and take to the store, 
showing the various discounts. This is another very easy spreadsheet application. 
 
To begin, we decide on the axes of the table: The left column is the "dollars spent" column, showing $10.00 
increments, and the top row is the "CDs purchased" row, showing 1 CD increments. These are both number 
series, but the spreadsheet software doesn't automatically provide series fill for numbers. So we must choose it, 
or fill in the series using formulas, which is also possible, of course. For the top row, we fill the first and 
second cells with 1 and 2 and then fill across. 
 

   
 
 
For the left column, we enter the first two items, $10..00 and $20.00, select the pair, and fill down. 
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The software figures out that we want to increment by $10.00. All that remains is to specify the table entries. 
For that, we write a formula. 
 
For each $10.00 spent the store gives a $1.00 credit. So, part of the formula is to divide the item in column B 
by 10. For example 
 
=$B3/10 
 
To ensure that the number we are dividing is always in column B, we make the column reference absolute. The 
row reference should be relative because we want the calculation to apply to whatever row the formula is in. 
 
The store also gives $3.00 credit for every two CDs purchased. The easiest way to apply this rule is to multiply 
the CD axis entry (in row 2) by 3/2. 
 
=(3/2)*C$2 
 
which is the right answer when the number of CDs is even, but for an odd number of CDs it is too much by 
half. For example, 1 * 3 / 2 is 1.5, that is, $1.50, but the store only gives $1.00 credit. The solution is to throw 
away any fractional digits, that is, to truncate the number. Spreadsheets have a function, trunc, for this purpose, 
 
=trunc((3/2)*C$2) 
 
As with the first rule, we use an absolute reference and a relative reference. Row 2 is absolute so that all entries 
refer to it, but the column should be relative, so that the computation applies to the column that the formula is 
in. 
 
The combined formula for both discount rules is 
 
=$B3/10 + trunc((3/2)*C$2) 
 
I, which we enter into cell c3.This yields the right answer, $2.00 ($1.00 for the amount paid plus $1.00 for the 
single CD). 
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Filling the formula down the column and then across the rows produces the final table. 
 
 

   
 
We can print out the table and take it with us to the store to help strategize our purchases to get the biggest 
discount. For example, we might trade CD purchases with a friend to get a larger combined discount, which we 
then share. 
 
The table was easy to construct. We used two series, one for the dollars and one for the CDs, to create the axes. 
The table entries used a single formula that referenced the axis entries with one absolute and one relative 
coordinate so that the entry for the column/row position was computed correctly. This technique works 
whenever we have two axes. 
 
Paying Off a Loan 
 
Suppose you are considering a large purchase, which may or may not have woofers. Your uncle has agreed to 
lend you the money, but ever the businessman, 
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he's charging you 5 percent interest. To decide how much to spend, you want to create a table of the monthly 
payments required for different amounts borrowed for different times. The table set-up follows the strategy of 
the last section: Fill a row across the top with different numbers of payments, and fill a column with different 
amounts. 
 

   
 
Among the functions available with spreadsheets is the "payment" computation, PMT. When we click on it 
under the Insert > Functions . . . menu, a GUI is displayed for PMT.  
 
 

  
 
The inputs to the function are the interest state, the number of payments (rrper), and the present value, or the 
amount of the loan (Pv). As with the discount table above, the inputs mix absolute and relative references to 
refer to the row and column entries. The formula result, shown at the bottom of the GUI, is the amount 
required to repay $1000 in six payments. Notice that the result is negative, i because the payment is a cost to 
you. 
 
Filling the formula down the column and across the rows results in a table with red, parenthesized values, 
which is the default display form for negative numbers. 
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If we don't like the parentheses, we can reformat the entries, say leaving them red. 
 
Perhaps, because the table is intended to help us decide how much to borrow, the best way to display the 
entries is to display them in two colors: Green for those within our budget and red for those over our budget. 
Deciding that a payment of $250 per month is a comfortable limit, we click on Format > Conditional 
Formatting . . . and get this GUI. 
 
 

     
We specify that cells greater than or equal to -250 should be formatted green. (Remember, the numbers tell 
how much we pay, so a number closer to 0 means less.) The green font is specified by clicking on the Format . 
. . button and picking a color. The final result makes it visually easy to decide how much to borrow. 
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Importing Data 
 
Much of the data we are interested in comes from some other source, that is, we didn't produce it. This 
probably means it has already been organized, and so may already exist in a spreadsheet or in a table in another 
application. Call this foreign data-data from another application that we want to import into a spreadsheet. 
Though importing previously formatted data into a spreadsheet can be tricky, there are some guidelines to 
make it easier. 
 
As a rule spreadsheets prefer to import foreign data as tab-delimited text. "Text" means ASCII text, that is, 
files with . txt extensions. Because they are text files, numbers like 100 are represented as three numeral 
characters rather than as a single binary number. This allows the spreadsheet software to convert the ASCII 
form into whatever internal number representation it prefers. "Tab-delimited" means that each cell's entry is 
delimited (ends with) a tab in the file, and each row is delimited with a carriage return (the symbol that results 
from pressing Return or Enter on the keyboard). Other delimiters are recognized, too, such as spaces and 
commas. Spreadsheets can output their lists as tab-delimited text. Copying and pasting tab-delimited text is a 
simple way to import foreign data. 
 
Lists with some other form can often be converted into the preferred tab-delimited form by copying the foreign 
data into a text editor or word processor and editing it using Search/Replace, possibly using the Placeholder 
Technique (Chapter 2). The goal is to substitute a tab or other preferred delimiter for a delimiter in the file that 
the spreadsheet software doesn't understand. Writing the result to a text file eliminates any formatting 
characters from the word processor. 
 
Another important source of data is the World Wide Web. The information is already in text form, and often is 
formatted with HTML table tags, as described in Chapter 4. It seems it should be possible to Copy a table from 
HTML and Paste it into a spreadsheet. For some browser-spreadsheet combinations it works, and for others it 
doesn't. It all depends on how the browser delimits "copies" taken from the screen. If you try to Copy/Paste 
table data from the Web and it doesn't work, try another browser before beginning the tedious task of 
reformatting the foreign data by other means. You'll probably get lucky 
 
Guidelines for importing foreign data: 
 

 When possible, save foreign data as tab-delimited ASCII text in a file with a . txt extension. 
 

 When foreign data comes from the Web, select a browser that supports Copy/Paste of tagged tables. 
 

 When the foreign data format is messed up, use a text editor with Search/Replace, apply the 
Placeholder Technique, and write the revised data with a . txt extension. Import. 
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For example, suppose you want to print out a custom bus schedule. Transportation schedules often include 
more data than we need, so if we grab a copy of the whole schedule from the Web, we can trim and edit it to 
match our needs in a spreadsheet. Visiting the city's Web page, we locate the bus schedule and Copy/Paste it 
into the spreadsheet, as shown in Figure 13.4. 
 

    
 
Figure 13.4. Bus schedule from the Web selected for copying. 
 
We only want the departure time from our stop and the arrival time at campus. By deleting columns we can 
create a simple two-column schedule. Adding the two columns for the return trip produces a custom schedule, 
as shown in Figure 13.5, that can be printed and kept in a wallet or purse. 
 
 

    
 
Figure 13.5. Customized schedule with "to campus" in white, `from campus" in blue. 
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Arranging Columns 
 
Spreadsheets are designed to manipulate rows and columns of information easily. Most other applications are 
good with rows, but not columns. For example, it is common in word processing to present a list of 
information, one item per line, as in this 77-item list of Best Picture winners 
 
Million Dollar Baby, 4 / 7, Clint Eastwood, 2004 Lord of the Rings: Return of the King, 11 / 11, Peter Jackson, 
2003 Chicago, 6 / 13, Rob Marshall, 2002 A Beautiful Mind, 4 / 8, Ron Howard, 2001 Gladiator, 5 / 12, Ridley 
Scott, 2000 
……… 
 
which includes Oscar awards / nominations, director, and year. 
 
Though the lines may not be intended as a table, when each one contains the same information, we naturally 
align it into a table in our minds. Adding new rows is easy Inserting or rearranging the columns is a headache. 
Spreadsheets can help. 
 
To manipulate columns in an application not well suited to the task, we must create a consistently delimited 
text file of the data, and import it into a spreadsheet, as described above. (Most entries are delimited with 
commas, so only the "/" presents a problem.) We then manipulate the list, and write out the file as text. After 
being revised in the spreadsheet, the file can be returned to the application. We will illustrate the idea by 
rearranging the columns of the movie list above. 
 
For example, suppose we want to reorder the columns so the year follows the movie, and change the awards / 
nominations data so it reads, for Million Dollar Baby, "4 of 7 Oscars." 
 
To begin 
 

 Make a file containing only the list 
 Use Search/Replace to replace every space-slash-space (" / ") with a comma (", "), so that the numbers 

get separate columns.  
 Import the file into the spreadsheet 

 
The result is shown in Figure 13.6. 
 
 

   
 
Figure 13.6. The movie list imported into a spreadsheet. 
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Using Cut and Paste we move the last column to become the second column. We also create a new column 
that allows us to combine the awards and nominations into one phrase. The formula uses an operation called 
concatenate, which means to join pieces of text together, one after the other. We will join four pieces of text 
together-the number of awards, the text " of " (bofb), the number of nominations, and the text " Oscars" 
(bOscars). awards " of " nominations " Oscars" 
 
This is expressed by the formula 
 
=concatenate(c3," of ",d3," Oscars") 
 

  
For the movie Million Dollar Baby, the formula produces the phrase: 4 of 7 Oscars. The function concatenate 
can join any number of text pieces, and is a  handy tool for combining words and numbers. 
 
The result, after filling into column c, is shown in Figure 13.7(a). This revised column converts two columns of 
data to a phrase that can replace them. We move the two numerical columns to the end of the table (we need to 
keep them or the concatenate formula won't work) and reorder the columns as we intend (see Figure 13.7b). 
 
To complete the table, we want to Cut and Paste the Oscars column into column E and throw away the last 
two data columns. But if we do that, the data that the Oscars column depends on will be gone. What we must 
do is Paste the Oscars as values, that is as text, into column E. So, we use Edit > Paste Special . . . and select 
"values". This converts the Oscars column from formulas to text; it no longer depends on the data columns (see 
Figure 13.7c). 
 
This completes our revisions, and we return the final spreadsheet to our document. 
 
Million Dollar Baby, 2004, Clint Eastwood, 4 of 7 Oscars 
Lord of the Rings: Return of the King, 2003, Peter Jackson, 11 of 11 Oscars 
Chicago, 2002, Rob Marshall, 6 of 13 Oscars 
A Beautiful Mind, 2001, Ron Howard, 4 of 8 Oscars 
Gladiator, 2000, Ridley Scott, 5 of 12 Oscars 

…… 
The result achieves our intended columnar modifications. 
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 A 
 

  
 B 
 

  
 C 
 
Figure 13.7. Revising the movie list. (a) constructing the phrase, (b) reordering the main columns, (c) the 
completed table. 
 
SUMMARY 
In this chapter we explored the basic ideas of spreadsheets. We found that: 
 

 Spreadsheets present an array of cells each of which is capable of storing one data item, a number, a 

letter sequence, or a formula. 

 Numbers and text can be formatted so that they display as we preferproper font, correct number of 

digits, etc. 

 The power of spreadsheets comes from entering formulas that calculate new values based on the values 

in other cells. 

 The formula is one side of an equation, which the computer solves for us, preserving the equality 

whenever the numbers that the formula depends on are changed and displaying the new value in the 

cell. 
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 In addition to performing arithmetic on the cells, we can apply functions to individual items or to whole 

cell ranges. 

 Both relative and absolute references to cells are needed depending on the circumstances. 

 In addition to sorting, there are functions for finding totals, averages, the maximum or minimum, etc. 

 Spreadsheets are a practical tool for routine computing. 

 It's easy to teach ourselves more about spreadsheets simply by trying them with courage. 

 Spreadsheets may be the most useful software for personal computing.  
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EXERCISES  Exercises 
 
True/False 
1. Text too wide to fit into a cell is truncated. 

2. Cells in a spreadsheet are 10 characters wide. 

3. Spreadsheets are most-commonly used to process numerical data. 

4. Copy/Paste will duplicate a formula, but it won't utilize relative and absolute cell references. 

5. The small box or tab in a selected cell's lower right corner is used to move the contents of a cell. 

6. A cell reference cannot contain relative and absolute references at the same time. 

7. To change a relative cell reference to an absolute reference, you should use the ampersand 

8. Spreadsheet columns can be hidden but rows cannot. 

9. Text files are generally stored in ASCII format. 

10. A spreadsheet can import any kind of data. 

 
Multiple Choice 
 
1.  A series of cells is called a(n) 
 A. tuple 
 B. group 
 C. array 
 D. sheet 
 
2.  Respectively, rows and columns are designated with 
 A. numbers, letters 
 B. letters, numbers 
 C. numbers, numbers 
 D. names, numbers 
 
3.  Which of the following is a valid range of cells? 
  A. D1:D4 
  B. C3 : D5 
  C. A1:E1 
  D. all of the above 
 
4.  Which of the following is not a valid range of cells? 
 A. Al>A5 
 B. C3-C8 
 C. 3B: 6B 
 D. all of the above 
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5. How many cells are in the range s2 : n7? 
 A. 6 
 B. 12 
 C. 18 
 D. unknown 
6. Spreadsheet formulas start with 
 A. + 
 B. _ 
 C. 
 D. ! 
7. The results of a calculation in a spreadsheet cell are displayed in 
 A. the cell to the right 
 B. the cell immediately below 
 C. the cell where the formula is written 
 D. front of the formula 
8. Filling is also known as 
 A. moving 
 B. formatting 
 C. replicating 
 D. clearing 
9. Which of the following is a completely relative cell reference? 
 A. J4 
 B. $J4 
 C. J$4 
 D. $J$4 
10. If the formula =$B$3 * .062 is copied from cell B4 to B5, the result will be 
 A. =$B$4 * .062 
 B. =$B$3 * .062 
 C. =B5 * .062 
 D. an error 
11. If $G5 appeared in a formula, you'd know 
 A. the G is absolute and the 5 is relative 
 B. the G is relative and the 5 is absolute 
 C. both are relative 
 D. both are absolute 
12.  is the character used to create an absolute cell reference. 
 A. 
 B. _ 
 C. 
 D. $ 
13. You generate a carriage return when you press 
 A. S acebar 
 B. Tab 
 C. Return 
 D. Shift 
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Short Answer 
 
1. Cell entries are , that is, the computer will not consider any of their constituent parts. 
 
2. A    is the vertical arrangement of cells in a spreadsheet. 
 
3. A   is the horizontal arrangement of cells in a spreadsheet. 
 
4.                   A group of one or more cells is called a(n) 
 
5. The small box in the lower right corner of a selected cell (or range of cells) is called the  
 
6. A(n)  cell reference automatically transforms a formula when it is pasted or filled. 
 
7. A(n)                       cell reference retains a reference to a fixed position when it is pasted or filled. 
 
8.                 are formulas built into a spreadsheet to make it easier to create calculations. 
 
9. Use the                        function to find the largest number in a range of cells. 
10. Use the                         function to find the smallest number in a range of cells. 
11. A                     is a range of cells filled with increments of a certain type of data. 
12. Use the                      function to find only the integer portion of a number. 
13. The                         function should be used to determine loan payments. 
 
14.                   is useful data that exists in a form that was created by a different application. 
 
15.              means "to join together." 
 
Exercises 
 
1. Look through the list of functions for a spreadsheet. Make a list of 10 functions and how you could use 
them. 
 
2. Use a spreadsheet to create a checkerboard. Resize the rows and columns of a spreadsheet to make 8 rows 
and 8 columns of equal size. Color alternate squares red and black. Print it in color. 
 
3. Take a bag of M & M's®. Count the number of each color. Create a spreadsheet from this. Write down 
each color and put the number of M & M's of that color in the cell next to it. Change the color of the cells to 
match the color of the M & M's. Write a formula to find the total. If you want, create a pie chart for this. Select 
the colors and the numbers. Create a chart and select pie chart. Edit it as needed. 
 
4. Find the number of rows in your spreadsheet. Click on a cell and hold down the ~1 key until it stops. Find 
the number of columns in your spreadsheet. Click on a cell and hold down the R key until it stops. Columns 
are labeled with letters. Once you get to column z, numbering starts over with AA. Calculate the number of 
columns. Then use the spreadsheet to calculate the 
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number of cells in the spreadsheet. Use one cell for the number of rows. Use another for the number of 
columns. Write the formula to display the answer in another cell. 
 
5. Create a spreadsheet to display the classes in your plan of study. Use a column for each semester and 

enter the classes below it. 
 
6. Modify the spreadsheet for Paying Off a Loan. Change it so you can enter the interest in a cell and have 

the cell in your formula. Test it to see how changes in the interest rate affect your ability to repay the 
loan. 

 
7. Go to http://www.dairki.org/tides/monthly.php. Select a location and get the tide charts for that month. 

Copy the data and Paste it into a spreadsheet. Change the formatting of it to suit your tastes. 
 
8. Create a spreadsheet to calculate the future value of an investment. Use the FV function for this. Future 

value is the value of a monthly investment at a certain rate over a period of time. You could use it for 
calculating your retirement nest egg. Enter the number of years in a row near the top. Start with 5 and go 
to 40 by fives. On the side enter the amount you're willing to invest each month. Start with $100 and fill 
it to $2,000. In the cell above the $100, enter the interest rate you expect to earn on the investment. In 
the first cell of the table (where the 5 and $100 intersect, enter your formula. Use FV The first one is the 
interest rate. Enter that cell. The second one is the years. Enter that cell. The last one is the amount. 
Enter that cell. When you fill using this cell the formulas won't work. You'll need to modify them to 
always stay in the interest rate cell. You'll need a $ in front of the row and column. For the years, you'll 
need the $ in front of the column. For the amount, you'll need the $ in front of the row. You'll then be 
able to copy it. The numbers will be negative. To make them positive (after all it's money you're saving), 
use the absolute value function (Ass). 

 
9. Create a personal budget. Put income in its own column. Total it. Put expenses in another column. Total 

it. The more accurate you are, the closer your budget will be. There should be at least a little money left 
over at the end of the month! 

 
10. Create a GPA calculator. Enter your classes in one column. Next to it enter the number of credits. Next 

to that enter the grade points earned for that class. (Usually it's one point per credit for a D, two per 
credit for a C, three per credit for a B and four per credit for an A.) Total the credits and the grade 
points. The GPA is grade points divided by credits. 

 
11.  Create a spreadsheet of your expected annual income. Put the year into a column and fill it up until the 

year you expect to retire. Next to the first year, enter your expected annual income. In the next cell, enter 
a formula to add three percent to the first year's income. Fill this formula for the rest of the years. If you 
put the percentage increase in a cell of its own and then use that in the formula you'll be able to change 
the annual salary increase to see how that affects your pay. 
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